
................................................................

More information on this plug-in is available
through Hot Door, Inc.
on-line: http://www.hotdoor.com/
phone: 530-274-0626
fax: 530-274-0727
email: transparency@hotdoor.com

User guide for Power Macintosh®

and Windows® platforms

About Transparency .........................2
Installation .......................................3
Registration......................................4
Where to find help ...........................5
Quick start........................................6
Overview ..........................................7
Making lenses..................................9
Using transparent artwork in
   other applications .......................11
Tips and techniques .......................12
Troubleshooting ............................ 13
Other Hot Door products ...............15
Order form .....................................16

© 1998 Hot Door, Inc.
101 W. McKnight Way, Suite B, Grass Valley, CA  95949

for Adobe® Illustrator®  8

hot door

©1998 Hot Door, Inc. This manual,
as well as the software described in
it, is provided under license and
may not be copied by any means
without written consent of Hot Door
except in accordance with the terms
of the license. The existing artwork
may be protected under copyright
law and unauthorized use of this
artwork could violate the rights of
the original author. Hot Door, the
Hot Door logo, Hot Door
Transparency, and the Transpar-
ency logo are trademarks of Hot
Door. Adobe and Adobe Illustrator
are registered trademarks of Adobe
Systems, Inc. Windows is a
registered trademark of Microsoft
Corporation. Apple, Macintosh,
and Power Macintosh are
registered trademarks of Apple
Computer, Inc. All other trade-
marks are the property of their
respective owners.

HOT DOOR DOES NOT AND
CANNOT WARRANT THAT THE
SOFTWARE IS FREE FROM ALL
BUGS, ERRORS AND OMISSIONS.
HOT DOOR MAKES NO
WARRANTIES, EXPRESSED OR
IMPLIED, INCLUDING WARRAN-
TIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO
THE RESULTS AND PERFORMANCE
OF THE SOFTWARE IS ASSUMED
BY YOU. HOT DOOR OR ITS
SUPPLIERS WILL IN NO EVENT BE
LIABLE TO YOU FOR ANY
CONSEQUENTIAL OR INDIRECT
DAMAGES, INCLUDING ANY LOST
PROFITS OR LOST SAVINGS,
ARISING OUT OF THE USE OR
INABILITY TO USE THE SOFTWARE,
EVEN IF HOT DOOR HAS BEEN
ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES, OR FOR ANY
CLAIM BY ANY THIRD PARTY.
Because some jurisdictions do not
allow the exclusion or limitation of
liability for consequential or
incidental damages, the above
limitations may not apply
to you.

Table of contents

Transparency



................................................................

Welcome to Hot Door Transparency - a plug-in
for creating live transparency effects within
Adobe Illustrator 8 for Power Macintosh or
Windows platforms. Hot Door Transparency
transforms Illustrator artwork into transparent
lenses which can be moved and edited with
ease. Text, objects, and colors can overlap with
any level of transparency with a dynamic
preview. The effect updates automatically when
you adjust transparency, shape, color, or
location to enhance the creative illustration
process.

What you can do with lenses
Transparent lenses are vector graphics which
appear transparent over other vector graphics.
Lenses can be made from one or more closed
paths filled with any color including:

• A single object or groups of objects
• Masked objects
• Text (if outlined and compound released)

About Transparency

Artwork that can appear underneath
transparent lenses includes:
• Objects with fills or strokes of any color
• Other lenses
• Text
• Gradients
• Patterns
• Masks
• Compound paths
• Blends (if expanded)
• Live brushes (if expanded)
• Meshes
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Macintosh or Windows Installation
To install the demo version of Hot Door
Transparency for Macintosh or Windows,
follow these steps:

1. If you are currently running
Adobe Illustrator 8, quit the application.

2. On Macintosh platforms, double-click
Install Hot Door Transparency on the disk.
Follow the on-screen instructions to install the
file named Transparency into the Plug-ins
folder on your drive. On Windows platforms,
locate the Plug-ins folder inside your Adobe
Illustrator ® 8 folder. Copy the file named
Transparency.aip from the disk to the
Plug-ins folder on your drive.

3. Launch Adobe Illustrator 8 and open the
Transparency palette by selecting Window >
Show Transparency.

Installing the
Transparency plug-in
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Reminder:
By sending your complete registration
information to Hot Door, you will receive
product upgrade notices and free
technical support.

E-mail the registration information to
transparency@hotdoor.com
or fax to 530.274.0727

Registering the
Transparency plug-in

This information will not be sold or distributed by Hot Door, Inc.
Please provide the following information to be eligible for upgrades
and technical support:

Serial Number: (on the sticker on the Transparency package)

____________________________________________________

Date purchased: ______________________________________

Name: ______________________________________________

Company:____________________________________

Street Address:

____________________________________________________

____________________________________________________

City: ________________________________________________

State/Province: _______________________________________

Zip/Postal Code:______________________________________

Country:_____________________________________________

Phone: ______________________________________________

E-mail (not distributed - for Hot Door product info only):

____________________________________________________

Where did you purchase Hot Door Transparency?

____________________________________________________

In what profession do you plan to use Hot Door Transparency?

____________________________________________________

Transparency registration™hot door
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This user guide
This user guide is in pdf format which can be
viewed and printed with Acrobat Reader 3
which is located on your Adobe Illustrator cd.

On-screen help
The buttons in the Transparency palette
change the mouse pointer to an icon that
describes the function of the button.

On-line FAQ
Frequently asked questions about
Transparency are answered on the
Hot Door Web site at
http://www.hotdoor.com/transparency/

Feature requests
Please send your comments and questions to
transparency@hotdoor.com.

Phone and e-mail technical support
If you send in your registration information,
you will receive free technical support from
Hot Door, Inc.

Where to find help with
Transparency
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Quick start

To begin using Transparency
1) After properly installing the Transparency
plug-in for Illustrator 8, launch Adobe Illustrator.

2) When Illustrator opens, open an existing file
or create new artwork on your page. To view the
Transparency palette, choose
Window > Show Transparency.

3) Select a closed path that you would like to
make into a lens to reveal objects underneath.

4) Click the Make button in the palette to
transform your object into a transparent lens.
Use the slider to set the desired level of
transparency.

5) Repeat steps 3 and 4 to create multiple
lenses. Refer to the About Transparency
section of this guide to determine what type of
artwork can be made into lenses or affected by
lenses.

6) If you move or edit your lens or artwork, click
the Update button to refresh the screen. Check
Live Update to automatically view changes.

7) To disable the transparent effect created by a
lens, select the lens and click the Release button
in the Transparency palette.

8) To transform your lens and its underlying
artwork into a set of masked objects, click the
Expand button in the Transparency palette. This
step will create additional artwork but may be
useful if you plan to open your artwork with
previous versions of Illustrator or without the
Transparency plug-in installed.
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Overview

Transparent lenses can be made from vector
artwork within Adobe Illustrator 8 using the
Hot Door Transparency palette. When artwork is
made into a transparent lens, it remains vector
artwork while appearing transparent over other
vector graphics.

Making a lens
By selecting artwork and clicking the Make
button, hidden artwork is created to produce a
transparent effect. This hidden artwork is a set
of linked masks of the original artwork with
color adjusted according to the transparency
level. Use the slider to set the desired level of
transparency.

Releasing a lens
If the transparent lens is released with the
Transparency Release button, the transparency
effect is disabled and the hidden artwork is
deleted.

Expanding a lens
If the transparent lens is expanded with the
Transparency Expand button, the hidden
artwork becomes selectable and unlinked. Since
there are many objects in this artwork group,
you may not want to expand a lens unless you
have completed your illustration. Expanding is
necessary to retain the transparency effect when
opening Illustrator 8 without the Transparency
plug-in installed. You do not need to expand
lenses to export or save in PDF or EPS format to
retain the transparency effect.

Note: The hidden artwork used to create the
transparent lens effect does not increase file size
unless the lens is expanded with the
Expand button in the Transparency palette.
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Overview (cont.)

Using Live Update
By checking the Live Update checkbox in the
Transparency palette, lenses update automati-
cally when you adjust their transparency, shape,
color, or location.

Since live update increases the time required to
preview artwork, you may want to turn off Live
Update when you have a complex illustration
or use the following objects in your document:
1) live blends or brushes
2) patterns or gradients
3) complex meshes

Note: The screen must completely redraw before
you are able to continue working with the
artwork. If you experience an incomplete
preview of a complex illustration, uncheck the
live update button and click the manual update
button.

Using the Update button
By unchecking live update and clicking the
Update button, you can manually preview
artwork changes that affect lenses. Use manual
updating to improve preview performance with
complex illustrations containing many lenses,
live blends or brushes, patterns or gradients,
or meshes.
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Lens compatibility
Lenses can be made from one or more closed
paths filled with any color, including:
• A single object or groups of objects
• Masked objects
• Text (if outlined and compound released)

Artwork that can appear underneath
transparent lenses includes:
• Objects with fills or strokes of any color
• Other lenses
• Text
• Gradients
• Patterns
• Masks
• Compound paths
• Blends (if expanded)
• Live brushes (if expanded)
• Meshes

Lens incompatibility
Lenses cannot be made from:
• Unclosed paths
• Text (unless it is outlined and compound

released)
• Stroke colors
• Gradients and patterns
• Meshes
• Live blends
• Live brush effects
• Bitmap images
• Compound paths

Artwork which does not appear properly
underneath transparent lenses includes:
• Live blends (unless expanded)
• Live brush effects (unless expanded)
• Bitmap images

Making lenses
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Turning artwork into lenses
To make a transparent lens, select a closed path
that you would like to make into a lens to reveal
objects underneath. Click the Make button in
the palette to transform your object into a
transparent lens. Use the slider to set the desired
level of transparency of the lens.

Note: You may notice that lens artwork only
appears transparent where it overlaps
underlying artwork. To make an entire lens
object appear transparent, create “background”
artwork – typically filled white – under your
lens artwork or document.

Once you have turned artwork into a lens, you
can edit it like other Illustrator artwork. Changes
made to the lens or its underlying artwork can
be previewed automatically when Live Update
is checked or when the Update button is
clicked.

Multiple lenses
You can create a stack of multiple lenses by
making lenses from overlapping objects. You
can also move lenses over other lenses to create
a more complex composition with transparency.
Note: To improve preview performance of
illustrations containing many lens stacks, try
using the Update button and unchecking Live
Update.

Editing lenses
Lenses are vector artwork and can be edited like
other Illustrator artwork. Likewise you can
change the stacking order of lenses by using the
stacking commands in Illustrator. Lenses that are
copied and pasted retain their transparent
effect.

Removing the transparent effect
If the transparent lens is released with the
Transparency Release button, the transparency
effect disappears.

Making lenses (cont.)
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Using lenses within Adobe Illustrator
If the Hot Door Transparency plug-in is installed
in the Illustrator 8 plug-ins folder, lenses will be
retained in Illustrator 8 documents when you
reopen them. If you plan to open your docu-
ments with another copy of Illustrator 8 without
the Hot Door Transparency plug-in installed, you
will need to expand the lenses to retain their
transparent effects. To expand a lens and its
underlying linked artwork, select the lens and
click the Expand button in the Transparency
palette.

If you save your document in an Illustrator
format other than Illustrator 8, lenses will
automatically expand into unlinked, selectable
artwork for compatibility.

Preparing lens artwork for use in other
applications
You do not need to expand lenses to retain their
transparent effects when exporting or saving
files in PDF or EPS format. When saving your
file in EPS format compatible with a previous
version of Illustrator, lenses and underlying
artwork will automatically be expanded. When
exporting your file, lenses and underlying
artwork will automatically be rasterized.

Note: Lenses and underlying gradients and
patterns will need to be rasterized prior to saving
your file in PDF format. Remember to save a
copy of your file in Illustrator 8 format prior to
rasterizing and saving in PDF format if you want
to retain the lenses as vector artwork.

Using transparent artwork
in other applications
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Improving preview performance
To improve preview performance, you may want
to use manual updating with complex illustra-
tions containing many lenses, live blends or
brushes, patterns or gradients, or meshes.
By unchecking live update and clicking the
Update button, you can manually preview
artwork changes that affect lenses.

You may also want to rasterize a lens and its
underlying artwork with Illustrator’s Rasterize
command. Rasterization will convert the selected
artwork into a bitmap image. Note: Be sure to
select the lens as well as its underlying artwork.
If you only select the lens, the rasterization will
only affect the area inside the lens and the
underlying artwork outside the lens will
disappear.

Working with text as lenses
Text, outlined text, and compound paths cannot
be made into lenses. To work with text, use the
Type > Create Outlines and Object > Com-
pound Paths > Release commands to convert
text into compatible artwork. Fill the transparent
interior spaces in the text with the color of the
background. Select the solid portion of text and
click the Make button in the Transparency
palette. Underlying artwork should appear
transparent.

Retrieving the “transparent” color of
underlying artwork
The Illustrator eyedropper tool does not pick up
transparent colors created by a lens. To retrieve
the color, copy and paste the lens and underly-
ing artwork. Select the duplicate group and
click the Release button in the Transparency
palette. Use the Soft Pathfinder command
in Illustrator to create component transparent
artwork with “transparent” mixed colors which
can be picked up by the Illustrator eyedropper
tool.

Tips and techniques
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Before you contact Hot Door technical
support
When you register your copy of Hot Door
Transparency, you will receive free technical
support and product upgrade information. If
you are experiencing problems with Adobe
Illustrator 8 and suspect that the problem may
be related to Hot Door Transparency, please
perform the following steps before contacting
Hot Door or Adobe technical support:
1) Quit Adobe Illustrator 8
2) Remove the Transparency plug-in from the
Adobe Illustrator 8 plug-ins folder
3) Relaunch Adobe Illustrator 8 and attempt to
recreate the problem. If the problem is solved
with the Transparency plug-in removed, contact
Hot Door. If the problem is not solved, refer to
the Adobe Illustrator 8 User Guide for further
solutions and troubleshooting.

Lens artwork does not preview
completely
Use manual updating with complex illustrations
containing many lenses, live blends or brushes,
patterns or gradients, or meshes. Uncheck Live
Update and click the Update button to
manually preview artwork changes that affect
lenses.

Problems saving or exporting
Files containing lenses over gradients or pat-
terns cannot be saved as PDF files. To save a
PDF file with this type of artwork, you need to
first expand or rasterize lenses and their under-
lying objects containing gradients or patterns.
Use the Expand button in the Transparency
palette to expand lenses and associated
artwork.

Very complex illustrations with lenses may
require more RAM to export. If one type of
export format is not successful, try using another
format and convert it to the desired format in
Adobe Photoshop.

Troubleshooting
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Undo doesn’t work
In some cases, the Illustrator Undo command
may not properly function with lenses. One
solution is to turn off Live Update in the
Transparency palette, choose the Undo com-
mand, and click the Update button in the
Transparency palette. In some cases, you may
only need to click the Update button to
properly preview the corrected mistake.

Eyedropper doesn’t pick up transparent
colors properly
The Illustrator eyedropper tool does not pick up
the nontransparent or transparent colors of
lenses or artwork under lenses. To retrieve the
nontransparent color of underlying artwork,
select the object and drag the fill or stroke
colors into the Illustrator swatches palette.

Fill and stroke attributes for lens are lost
If you make a lens object into a type path, you
will lose the fill and stroke attributes of the lens.

Lenses do not work over graphs
To make a lens over graph artwork, you must
ungroup the graph to view underlying artwork.

Troubleshooting (cont.)
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Other Hot Door products

• For technical illustrators, graphic designers,
architects, etc.

• 34 easy-to-use precision drawing tools
work just like Illustrator tools

• Draw in any scale for the first time
• Click and drag to quickly dimension

Illustrator artwork
• Create new shapes like walls and arcs –

even with numeric input
• Add fillets and chamfers to corners
• Instantly add labels and call-outs
• Instantly measure length of curves, area

and perimeter
• Avoid the headaches of learning a

complex CAD package!

• For graphic designers, desktop publishers,
Web publishers, etc.

• Interact with the true artist’s color wheel to
create exciting, harmonious color schemes
including complements, split complements,
triads, tetrads, and many more!

• Adjust the wheel’s tint, shade and tone for
thousands of variations

• Add and edit up to 30 color swatches with
familiar controls

• View schemes in Web colors – and even
copy HTML

• Copy, save, or export schemes to Adobe
Photoshop, Adobe Illustrator or Adobe
PageMaker

The complete technical drawing solution
for Adobe Illustrator 7 or 8

Hot Door CADtools 1.1

The creative color picking solution for
print or Web design within Photoshop

Hot Door Harmony 1.0

only $129 direct

only $79 direct

Demos on-line
www.hotdoor.com
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Order form

Name ______________________________________________________________

Company ___________________________________________________________

Address ____________________________________________________________

City ________________________ State/Province __________________________

Zip/Postal code ______________ Country________________________________

Phone ______________________ Fax ___________________________________

Email ______________________________________________________________

Where did you first hear about Transparency 1.0? ________________________

Hot Door, Inc.   www.hotdoor.com   knock@hotdoor.com
1.888.236.9540    530.274.0626    fax 530-274-0727
101 W. McKnight Way, Suite B  Grass Valley, CA  95949

Quant Item # Platform Description Price Ext.

TIM1 PMac Transparency 1.0 - AI8 $39.00

TIW1 Win Transparency 1.0 - AI8 $39.00

CADM11 Mac/PMac CADtools 1.1 - AI7/8 $129.00

CADW11 Win CADtools 1.1- AI7/8 $129.00

HPM1 PMac Harmony 1.0 - PS4/5 $79.00

MasterCard Visa        American Express

For more information about alternative shipping, academic pricing, and multi-license pricing call
530-274-0626 or send email to knock@hotdoor.com

Total

California residents add 7.25% sales tax

Subtotal

Priority mail 2-3 day US shipping for boxed product
Global priority approx. 1 week

($5 US, $13 Canada, $14 Western Europe, $16 Pacific Rim)

Name on card_______________________________________________________

Card number _______________________________________________________

Expiration date ___________ Billing zip code ____________________________

Signature ___________________________________________________________

E-mail delivery? __ yes __ no         E-mail delivery only - no box? __ yes __ no

Order direct
to save now!


